
 

Blitz Indexer 
 

Key features 
• Index photos and other files from your home directory and other drives or locations. 

• Quickly find photos, and other files, even if the volume they are on is o;line. 

• Browse photos and files by di;erent metadata fields (including camera make and 
model, author and copyright, date and GPS location, and many more) to discover 
files you had long since forgotten, or misfiled deep in the wrong folder. 

• Find duplicates and similar images (eg. scaled versions of a photo, or images with 
similar colours). 

• Search and browse and find duplicates in ZIP files and other archive formats, even 
on o;line volumes 

• Display geotagged images on a map, filtered by date, to show when you visited 
di;erent places. 

• Keep control over your images and files on your storage the way you want to, without 
being tied in to a proprietary system that someone else (whether Apple or Adobe or 
Google or Microsoft or Dropbox, or anyone else) might want you to use. 

• Super-fast proprietary database and search engine lets you search millions of files 
based on their name, metadata, or content in a fraction of a second for most 
queries, using simple but powerful plain text queries 

Basic operation 
• In ‘automatic’ mode, Blitz Indexer will automatically scan your home directory and 

mounted volumes in the background, as long the application is running, 
continuously looking for new or modified files and detecting when volumes are 
mounted or unmounted. 

• In ‘manual’ mode (uncheck Automatic Mode in the File menu) use File > Open to 
choose the directory to index, then Scan For New Files (to quickly list all the files in 
the directory) and Analyse Contents (to read thumbnails and metadata from the 
file). 



• Use Save Index File to save an index file in the directory itself (in a hidden package 
called .blitz), or Save As to save the index in another location (useful if you are 
indexing a removable volume and want to be able to search it when it is o;line). 

The indexing process 
Indexing your photos and other files consists of three distinct phases: 

• Scanning for new files looks through all the directories and subdirectories of the 
folder or volume being indexed, looking for any new files (also for files which have 
been deleted or moved) to quickly create a basic file list 

• Analysing the files is a slower process that involves reading the contents of each file 
and adding Exif and other metadata to the index, as well as a low-resolution version 
of the image or brief summary of other types of file (for example a contact sheet for 
movies, or a plain text version of formatted documents) 

• Building the search index involves building an optimised in-memory index of 
filenames, keywords, and metadata to speed up searches 

In automatic mode all of these processes are handled automatically, while in manual mode 
you have full control over when they are performed. 

Main window 
• Use the file list (top left of the window) to navigate all the items in the index by folder, 

listing files and directories by name 

  
• Click on a folder to show its contents 

• Press the “Up” button to move up to the parent folder and show the location of the 
selected file. 



• Click on a column header to sort the list 

• Press the “Flatten” checkbox to show all files anywhere below the selected folder, 
including in sub-directories. 

• Use the icon panel (at the bottom of the window) to view thumbnails of the files. You 
can choose the size of the thumbnail, and whether to show the filename or other 
metadata alongside the thumbnail. 

• Double click a file or image to view it, or use commands in the Item menu to copy or 
delete the file or reveal its location in the Finder 

• The metadata panel on the right shows detailed information about the selected 
image or file: 

 
• Clicking on a blue “link” will display other similar files with the same tag 

Menu organisation 
Because the basic items that Blitz Indexer deals with are files it is worth briefly explaining 
how the menus are arranged: 

Commands in the ‘File’ menu relate to the indexing process itself, and managing index files: 
opening or creating an index, enabling automatic mode or manually scanning for new files 
and analysing them, and whether to expand the contents of ZIP files and other archives. 



Commands in the ‘Edit’ menu are used to manipulate records in the index, such as tagging 
files as favourites or setting metadata to say an image should be rotated, while commands 
in the ‘Item’ menu work on the underlying files themselves, such as deleting or copying files, 
opening or viewing them, and so on. 

The other menus such as ‘Tools’ and ‘Help’ are reasonably self-explanatory. 

Searching and filtering 
• Type in the search box in the toolbar (and press the return key) to search indexed 

files by name or metadata, or the contents of text documents. 

• See below for details of the simple “Google-style” query syntax that can be used for 
advanced searches. 

• If you select one (or more) directories within the file list then the search is restricted 
to files within the chosen directory. 

• Use the Directories/Text/Media/Other checkboxes to filter which results are shown 

• Use the Duplicates checkbox to individually list all the identical copies of a file, 
rather than grouping them together into one row 

• Use the System Files checkbox to include files in hidden system folders 

• Use the Hidden Files checkbox to include files which have been tagged as hidden or 
secret 

Advanced searching 
You can search for photos and other files in many di;erent ways. Exactly what you can 
search on depends on the kind of file.  

You can search for files: 

• by their filename 
• by Exif metadata fields such as date, GPS coordinates, frame size, or exposure 
• by tagged metadata fields (such as camera make and model, author, file kind, video 

format, software used to save the file, language, artist and album, and many more, 
depending on the type of file) 

• by the title and comments fields found in many kinds of files, for example music files 
or O;ice documents 

• by the ‘reference’ field, which might store the original filename for a derived file, files 
that a QuickTime reference movie depends on, and so on 

• by the 3 or 4 dominant colours in an image 
• by keywords taken from the contents of text documents, including O;ice 

documents, PDFs, and HTML pages (though for large documents only the first 1MB 
or 10,000 distinct words are indexed) 

• by the directory or volume they are on. 

If you type in one or more plain text search terms it will search all the available information 
(file names, metadata fields, and contents keywords) and show all the results where at 
least one term matches. The more words that match the higher the score is. 



For finer control you can add advanced hints to refine the search. These are generally of the 
form prefix:value, where the prefix says which field(s) to search. Any advanced query terms 
to search specific fields must match for a file to be included in the search results. 

• Prefix a term with name:  to only search filenames, for example name:poi-5.2.2. 
(Note that this can also be used to find filenames that contain punctuation and 
special characters which aren’t include in the normal text-based search index.) 

• Prefix a term with contents: to only search the file “contents”, i.e. tagged metadata 
fields or content keywords, eg. contents:proposal. 

• If the prefix is in mixed case (eg. Name: or Contents:) then exact case is checked, 
otherwise it is case-insensitive. For example, Name:screenshot would find a file 
called “screenshot1.png” but not “Screenshot 2023-03-22 13.04.42.png” 

• Use recent: to view all photos, ordered by date. 

• Use favorite: or marked: to view items tagged as favourites or marked 

• Include a term starting with a period to only show files with a particular filename 
extension (for example .pdf or .jpg). 

• You can search on file size, image size, duration and page count metadata fields 
using <, =, or > operators, eg. Width>1024, Height<512, PageCount=10, 
Duration>5 Duration<10, Size<2.5MB, etc. (Searching for size=X includes 
files within ±25% of the target size.)  

• Queries for width and height support simple expressions, eg. use width<=height 
to find portrait images, or width=height*4/3 to find 4:3 aspect ratio photos. 

• You can also do numeric searches on aperture, exposure, ISO rating, and focal 
length. For example, FNumber=f8, FNumber<1.5, Exposure=1/125, 
Exposure>0.5, FocalLength=6.8, or ISORating=200. (Using an “equals” 
search for fnumber=X or focalLength=X actually allows a tolerance ±10%, while 
exposure=X allows ±25%). 

• You can do various queries on date. Use date (or OriginalDate) to search on the date 
the photo was taken or the document was authored if present (given by Exif 
metadata etc.), mtime (or LastModified) to search on file last modified time, or 
FirstDate to search on whichever of these is earlier. You can compare these with 
each other, with a specific date, year, year and month, or number of days relative to 
today,  eg. Date=2015, mtime<date, FirstDate=2022-12-31, mtime>-7 
(files modified within the past week), etc. (You can also search on the copyright or 
creation Year field, which is stored separately as a tagged metadata field.) 

• You can search on a specific tagged metadata field (like Make, Model, Author, Artist, 
Album, Video or Audio format etc.) by using the name of the field, eg. video:tiff 
or Author=”Rolf Howarth”. Quote the term if it includes spaces. 

• When querying metadata tags, use colon (:) for “includes” and equals (=) for “exact 
match”. So make:nikon would match “Nikon” or “NIKON” or “Nikon Inc.”, while 
make=nikon matches “Nikon” or “NIKON” but not “Nikon Inc.”.  (Again, if the query 
contains mixed case then case must match exactly, otherwise case is ignored, so 
Make=Nikon matches “Nikon” but not “NIKON”.) 



• Use comments, title or reference (followed by colon or equals) to search these 
fields, for example comments:draft, Title=”A Life In A Day”, or 
reference:img_2314 

• Prefix a plain term with ‘+’ if it must be included, or ‘–’ to exclude it, and use ‘|’ to 
separate alternatives, one of which must be included. So, for example, keyboard 
mouse computer would return files that contain at least one of those keywords 
(the more words that occur the higher the score would be), whereas +computer 
keyboard|mouse display|monitor would only return results with 
“computer”, and at least one of “keyboard” or “mouse”, and at least one of “display” 
or “monitor”. 

• As another example, Model:iPhone would display photos taken with any iPhone 
model, while Model=”iPhone 3GS” would show files from an iPhone 3GS only, 
and Model:iPhone -Model:3GS would show files from any iPhone except for a 
3GS. 

• You can use ‘*’ as a wildcard at the start, middle, or end of a search term, for 
example *phan* would find files containing “elephant”, “phantasia”, or 
“alphanumeric”.  

• Numbers of 6 digits or more are indexed. To simplify searching for phone numbers 
and the like, commonly used punctuation such as parentheses or hyphens or plus 
signs, e.g.  ‘(1)800’ or ‘+44’, are removed before indexing numbers, and any numbers 
ending with the search term are matched, in case the country or area code is there 
or not. (If you want to explicitly search for numbers starting with specific digits 
instead then you can append a ‘*’ wildcard to the end of the search term.) 

• You can search for files containing a particular resource using macresource:PICT 
etc. Use macresource= on its own to find all “Mac” files (any file which has 
type/creator) but no resource fork.  You can also search on data fork and resource 
fork size, eg. datafork<resourcefork or resourcefork>65535. 

• You can restrict a search to specific directories or volumes if you look up their 
FileID’s, e.g. dir:171,24351 would search just those volumes or directories (and 
subdirectories). Or use folder: or volume: to search by name and check that one 
of the file’s parent folders or the volume matches the given name, for example 
folder:pictures or volume=Untitled. Use online: or offline: as a 
shortcut to only search those volumes which are currently mounted and available 
(or not). 

Disk usage pie chart 
Use the Pie Chart tab to summarise the contents of a folder and understand what is using 
up your disk space: 

• The largest sectors around the central circle show which subdirectories of the 
selected folder are using up the most space 

• Click on a sector to expand that directory 
• Click on the parent folder name (in the top left title) to move back “up” a level 
• The grey segments represent folders, while the coloured segments represent files (of 

di;erent types, such as images or text files, as shown in the key on the right) 



 

Expanding archive contents 
By default, common archive file formats (including .ZIP, .TAR, .TGZ, .7Z, and .DMG files) are 
expanded in the index so you can browse, search, and view the contents of files within the 
archive, or copy them, as if they were normal files. The files are automatically expanded to 
temporary storage, but only when needed (and they are deleted again afterwards), so they 
don’t take up unnecessary extra space on disk. 

You can turn this functionality o; using the Expand Archives option in the File menu. (If you 
change this setting it only takes e;ect the next time the volume is scanned, whether using 
Scan For New Files or in Automatic Mode.) 

Volumes 
A Blitz index can describe files from many di;erent “volumes”, including your own personal 
home directory, the ‘shared’ data directory (/Users/Shared), external removable drives 
(such as USB drives, memory sticks and SD cards, CDs or DVDs, etc.), and network drives 
such as Windows SMB shares or NAS (“network attached storage”) volumes. 

At the top level of an index (keep pressing the Up button!) you can see all the available 
volumes, including volumes which are currently o;line: 

 
In automatic mode whenever a new volume is mounted it is scanned and added to the 
index automatically (and you are prompted to enter a description of the volume, for 
example a physical description of the memory stick). 

Volumes are normally managed automatically, but you can use the Manage Volumes 
command for finer control over the volumes in an index: 



• Use ‘+’ to manually add a directory to the index as a new “volume” 

• Use ‘–’ to remove a volume from the index. All details about the volume are forgotten, 
so if you are in automatic mode and mount the drive again it will rescanned as if it 
was a new volume. 

• Alternatively, click the checkbox alongside the volume name to disable a volume. 
This will hide it from the file list (and from search results, and prevent it from being 
scanned) but the index remembers details about the volume so it won’t be added if it 
appears again. 

• In “manual” mode you can index a volume (or directory) using the Open command 
and then save it as an index, and use the Import command to combine indexes 
together. This will result in a new ‘volume’ for that index. 

• Use the Export command to save selected volume(s) to a new index file, perhaps to 
archive volumes you are no longer interested in prior to deleting them, or to break a 
large index up into several smaller ones for specific purposes. 

• The Clean & Eject option is useful when indexing Windows USB memory sticks and 
will remove hidden Mac-specific files (like .DS_Store, .Trashes, and .Spotlight-V100) 
that the Finder might pollute the drive with, before unmounting the drive once it has 
been indexed. 

 

Finding duplicate files 
Blitz Indexer has several features to help you find and manage duplicate copies of a file: 

• When performing a query you might sometimes find several copies of the same 
matching file in di;erent locations or on di;erent volumes, in which case the file list 
collapses these and shows a single row for each unique file. 

• The count of files shown in the Files column. 

• Tick the Duplicates checkbox to expand the list and show all the files. 

• The Identical Copies tab shows all the other files which have exactly the same 
contents as the selected file. 



• The Visually Similar tab shows images which have similar contents to the selected 
image but aren’t identical copies of the file; perhaps the images were re-scaled, or 
their colour was adjusted. 

• You can also use the Find Duplicates window (see below).  

Find Duplicates window 
The Find Duplicates command will search for and display all the duplicate files within the 
selected folder(s) or volume(s). You can mark which versions to retain or to delete and then 
remove the duplicates. 

You can find: 

• identical copies of files,  
• duplicate directories, 
• archive files and expanded directories with the same contents, or 
• visually similar images. 

In each case the results are sorted by size, to help you see how much disk space you can 
save by deleting unnecessary copies. 

Within each group of files you can decide which of the copies to keep (✓) and which to 
delete (✗). 
Note: Although the Find Duplicates command has some built-in protections (for example, it 
won’t let you delete all versions of a file, or the highest resolution of an image leaving only 
lower resolution copies), you should still take care before confirming deletion as 
occasionally an unrelated image might be reported as being “similar”. 

 



Browsing related files 
• Use the Show Map window to show images with GPS location data on a map. You 

can also manually geotag other images if desired. (For more details on using the map 
window see below.) 

• Use the Tag Explorer window to list all the distinct metadata tags and values (such 
as camera make and model, file type, video format, author and copyright 
information, etc.) and show all the matching images and files: 

 
• Use the Camera Time Line window to show all the di;erent cameras you used over 

the years, and show all the images from any particular camera: 

 
• Other tabs at the bottom of the window (including Visually Similar, Similar 

Colours, Same Date, and Same Location) show other files which are related to the 
currently selected image: 



 

Tagging images (and other files) 
Use commands in the Item menu (or the corresponding keyboard shortcuts) to tag files as: 

• Favourites ❤  (highlight your best images so you can easily find them) 
• Marked ✓ (make a selection of files for a particular purpose) 
• Hidden ⊀ (uninteresting or private files are suppressed from view by default) 

If an image was tagged as a favourite or hidden on your iPhone then that tag is imported into 
the index, but note that any tags that you add in Blitz Indexer are stored in the index, not in 
Apple Photos, as you can tag files and documents other than images. (Similarly, if you add a 
location to files using the map, these are stored in the index and not in the file because you 
can add locations to files that don’t support geotags.) 

Use the Edit Comments command add notes or a description to files. Unlike tags and 
locations, these are stored both in the index and in the file itself (as Finder Comments in the 
file’s metadata). 

Using the map 
You can view the exact location where a photo or video was taken (assuming it contains Exif 
location data) using either the Apple Maps application or in Google Maps (which launches 
in an external web browser). You can also use the built-in base map viewer which is less 
detailed but works if you are o;line. 

Look at the GPSCoords field in the metadata panel and click on ▸M ,▸A, or ▸G to open 
the built-in map viewer, Apple Maps, or Google Maps respectively: 

 

You can click on the coordinates to toggle the display between degrees minutes and 
seconds or decimal degrees. 

Using the built-in map viewer: 

• Click on ▸M or use the View Map command, to open the built in map and show 
where the photo was taken. 



• If you don’t select a single photo then all the geotagged photos in the current view 
are shown. 

• You can switch the view between showing thumbnails, a count of images taken at 
each location, or coloured “age colour” blobs to indicate approximately how long 
ago you took photos in di;erent places. 

• Press the cog button (⚙) to display the map key and controls panel, where you can 
select the type of view: 

     
• Press the flag button (⚑) to launch Google Maps and show the current location in a 

web browser and show a more detailed map 
• Use the date slider at the bottom left of the window to adjust the date range and filter 

which photos are shown on the map 

• Press the circle button (∅) to clear any filters and show all the photos 

• Press the down arrow (⩡) to tag selected file(s) with the current map location. 
(Note that manually set locations are stored in the Blitz index, not in the file itself, 
but this also means you can tag files that don’t normally store location 
information.) 

• You can name your own favourite locations using the Save button on the Same 
Location tab. Named locations are shown in blue on the map, and can be used for 
searching. 

 

Movie maker 
Using the Movie Maker command you can combine still images and videos to create a 
relaxing “slow TV”-style video of landscapes and similar images (similar to Apple TV 



screensaver movies). This command is particularly designed for use with 4K drone footage 
(such as from the DJI Mini Pro 4 or similar). 

• Drag and drop files into the window to add them to the project or rearrange the order 
• Video is slowed down to 24fps for a cinematic e;ect 
• Slowly zoom in and pan over still images 
• Optionally include a description of the location or GPS coordinates in the corner of 

the image 
• Drone video with a slow, smooth, continuous movement works best. If the source 

movie includes rapid movements enter the start and end time in seconds of the 
smooth section you want to use. 

• Quickly preview the movie at double speed and then render it to the final output 
movie (either H.264 MP4 or MJPEG MOV) at full quality. 

• Double click an item to view it, or right click to edit the item’s settings. 
• The options are deliberately minimalist (eg. there is no audio, stills are always 20s 

long, the font size and position of titles is fixed).  
• All you choose for each item is whether to include a title in the corner, where to zoom 

in on still images, and where to start/end a video: 

 

Metadata fields 
Various types of information are read from a file, including: 

• Basic file system metadata (file size, last modification time, etc.) 
• MacOS Finder and Spotlight metadata 
• “Classic” MacOS metadata (file type and creator, and content of resource forks) 
• TIFF and Exif metadata from images (JPG, PNG, GIF, DNG, PSD, TIF, RAW, CR2, etc.) 
• QuickTime, ID3, and FFmpeg metadata from other media files (MOV, MP3, M4A, 

MP4, MXF, AVI, etc.) 
• Document metadata from common O;ice files (PDF, DOC, DOCX, XSLX, PPTX, etc.) 
• Information from reading the content of files (eg. character encoding and language 

of text files, processor architecture of executable files, etc.) 

A full list of fields that are stored in the index (to summarise the contents of a file and for 
searching) is shown below. Exactly which fields are available for any given file depends on 
the type of the file. 
 



AccountID For iTunes Music Store purchases 
Album The album for music files (from ID3 metadata etc.) 
Artist The artist for music files (from ID3 metadata etc.) 
Audio Codec and format for music files and movies (eg. ‘MP3’, ‘AAC (LC)’, 

‘pcm_s16le’, etc.) 
AudioChans The number of tracks or channels in a music file or movie 
AudioRate The audio sampling rate, for music files and movies 
Author The author of Word or PDF documents (if stored in the document’s 

metadata) 
ColorModel The bit-depth and colour model of the image, eg. ‘8-bit RGB’ (Exif 

metadata) 
ColorProfile The ICC profile name of the image, eg. ‘sRGB IEC61966-2.1’ (Exif 

metadata) 
Comments Any comments or notes found in the file, including Finder 

Comments, comments in Word or PDF document, TIFF comments, 
etc. May also detail any errors that occurred while analysing the 
file. Unlike most other fields this field is editable; if you edit the 
comments they are stored both in the index and as Finder 
Comments in the file. 

Company The author’s organisation for Word or PDF documents (if stored in 
the document’s metadata) 

Composer The composer of a music file (from ID3 metadata etc.) 
ContentPreview The size and type of a small preview that is stored in the index to 

describe the contents of a file, eg. a thumbnail image, or a 
compressed plain text version of Word documents (see also 
Thumbnail) 

Copyright Any copyright notice stored in TIFF or other metadata in the file 
Country Optional information about where a picture was taken or file 

originated that may be stored in TIFF or other metadata in the file 
(see also State) 

CropFactor Conversion factor between FocalLength and FocalLen35mm (if that 
is available from FocalPlaneResolution and PixelDimension Exif 
metadata) 

DominantColours Up to four dominant colours that occur in an image. Although not 
exact, this is used to find images containing similar colours. 

DownloadFrom Which web site the file was downloaded from if the file is 
quarantined by the Mac Finder 

Encoder The software or video codec used to encode the movie 
Encoding The character encoding for text files (eg. ‘UTF-8’, ‘Latin-1’, 

‘MacRoman’, ‘ISO-8859’, etc.), also the line ending (‘Classic Mac’, 
‘Unix’, or ‘Windows’) 

Exposure The camera exposure time when a photo was taken (Exif metadata) 
Favorite Indicates the image was marked as a favorite on your iPhone or in 

the Photos.app, which will result in the image being marked as a 
favourite in the Blitz index. Note that if you “favourite” an item in the 
Blitz index it won’t update the file itself (in Blitz you can favourite all 
kinds of files, even though macOS only supports favouriting image 
files). 



FileHash A hash calculated from the file’s contents, so if two files have the 
same contents they will have the same hash, while the chance of 
two files with di;erent contents having the same hash is very low 

FileID An ID for the file record within the Blitz index. 
Filename The name of the file in the file system 
FileType The basic type of the file as determined by Blitz Indexer (eg. 

‘Picture’, ‘Movie’, ‘ Document’, ‘Executable Library’, ‘XML Text’, etc.) 
FinderTag Any Finder tags stored against the file 
Flash Whether flash was used or not when a photo was taken (Exif 

metadata) 
FNumber The camera aperture when a photo was taken (Exif metadata) 
FocalLen35mm The “equivalent focal length” that the lens would correspond to on 

a classic 35mm film camera, if known. This gives an indication of 
field of view (where 28mm is considered wide angle, 50mm a 
standard lens, and 135mm a telephoto lens). This will di;er from 
the actual focal length, depending on the size of the camera’s 
sensor. See also CropFactor. 

FocalLength The actual focal length of the lens when a photo was taken (Exif 
metadata) 

Folder The file path of the parent folder where the file is located 
FrameRate The number of frames per second for movies 
FrameSize The width and height of an image or movie file 
Genre The music genre for music files 
GPSCoords The latitude and longitude where a photo or movie was taken, if this 

information is available in Exif or other metadata within the file. 
This field is editable using the map; if edited the new location is 
stored in the index (so you can set a location on files which don’t 
normally support location metadata). See also Location. 

HandlerName The media handler for QuickTime or MP4 movies  
Hidden Indicates the image was marked as hidden on your iPhone or in the 

Photos.app, which will result in the image being marked as a 
hidden in the Blitz index. Note that if you hide an item in the Blitz 
index it won’t update the file, as you can hide files other than 
images, as well as complete folders 

ImageHash Together with UncertaintyMask this is used to find visually similar 
copies of an image scaled to another size 

IndexedWords For text documents, a count of the number of unique words that 
are indexed and can be used when searching for this document 

Inode The Unix inode number is unique for each file within a volume 
ISORating The ISO gain when a photo was taken (Exif metadata) 
ItemContentType The Spotlight kMDItemContentType field, eg. ‘public.xml’ or 

‘com.apple.property-list’, for known extensions, or ‘dyn.*’ for 
others. 

Keyword Any keywords in TIFF or XMP metadata or in O;ice documents 
Kind The type of the file, as reported by the Finder or determined by 

analysing the contents of the file (eg. for executable binaries this 
may include the processor architecture) 



Language Which language or languages a text file or document is in, guessed 
by inspecting the contents of the file, including identifying anything 
that looks like computer code rather than plain text 

LatestMtime For folders, the latest modified time of any file within the folder 
Lens A description of the lens used when a photo was taken (Exif 

metadata) 
Linked For soft and hard links and for aliases a link to the next related file 
Location The name of a location if GPSCoords are present and the user 

entered a name for a nearby location 
MacCreator For Classic MacOS files the FOURCC “creator” code (eg. ‘R*ch’ or 

‘MOSS’) that typically describes the application used to edit the file 
MacResource See ‘ResourceTypes’ 
MacType For Classic MacOS files the FOURCC “type” code (eg. ‘TEXT’ or 

‘JPEG’) that describes the file format 
MajorBrand A FOURCC that gives more details about the type of file in an MP4 or 

QuickTime movie container 
Make The make of camera that was used when a photo was taken (Exif 

metadata) 
MetadataID An ID for the metadata record within the Blitz index that describes 

the file’s contents. If two files have exactly identical contents they 
will typically share the same file metadata record. 

Model The model of camera that was used when a photo was taken (Exif 
metadata) 

Modified The file system date the file was last copied or modified (see also 
OriginalDate and LatestMtime) 

Orientation The orientation of Exif images that says whether the camera was 
held in portrait or landscape orientation 

OriginalDate The date a photo or movie was taken or a document was created, if 
this is available in Exif or other metadata within the file (see also 
Modified) 

PageCount The number of pages or slides (for Word and PDF and PowerPoint 
documents) 

PalmCreator The FOURCC creator application signature for Palm OS PDB files 
PalmType The FOURCC file type signature for Palm OS PDB files 
Project The project name available for some movie files and O;ice 

documents 
Quarantine Which application download the file if the file is quarantined by the 

Mac Finder  
Reference A reference associated with the file (eg. if the file was derived by 

editing another file, a QuickTime movie references other source 
files, etc.) 

ResourceFork Size in bytes of a Classic Mac resource fork, if present 
ResourceTypes The FOURCCs of which types are present in the resource fork. When 

querying or browsing an individual type in the tag explorer it’s 
referred to as MacResource. 

SerialNumber The camera serial number (Exif metadata) 
Size The size of the file in bytes 



SizeOnDisk The total size a file actually occupies on disk, allowing for block 
sizes and resource forks etc. 

Software The software version that was used to create or edit the file 
Special Additional information for special files such as the path to the 

original file for symbolic links and aliases, special flags like ‘uchg’, 
the number of hard links to a file if it’s linked more than once, and 
so on. 

State Optional information about where a picture was taken or file 
originated that may be stored in TIFF or other metadata in the file 
(see also Country) 

Template The template an O;ice document was based on 
Thumbnail The frame size of the thumbnail preview (see also ContentPreview) 
Title The song title for music files or title of a Word or PDF document 
TotalFiles For folders, the total number of files within the folder (or nested 

subfolders) 
TotalSize For folders, the total size of all the files in that folder (or nested 

subfolders) 
Type The low level file type (for special files, symbolic links, etc.) 
UncertaintyMask Used together with ImageHash to determine if two images are 

visually similar 
Video The video format or codec for pictures and movies 
XMLKind The top level tag for XML files 
Year The copyright or creation year that might be stored in metadata in 

the file, eg. for music files 

Exporting data 
You can export data for selected files and directories in a wide variety of formats. 

With Export As Text you can: 

• Set up a template consisting of optional prefix (for example, a CSV header row) and 
su;ix, plus the main pattern to be repeated for each file 

• Use the field chooser and Copy button to copy selected fields into the template, 
including the specified separator between fields 

• Export as comma-separated (.csv) or tab-separated files (.tsv, .txt or .tab) for 
importing into spreadsheets and databases by choosing the appropriate separator 

• Export a shell script of commands, which you can run from the command line, to 
perform batch processing on selected files 

• Depending on the desired application you may need to quote any fields that might 
contain spaces or other special characters 

• Use the Preview button to see what the output might look like 

Use Export As XML to save an XML file, including thumbnails, that can be imported into the 
“CatDV” media asset management system 



Use Export As Image to export selected files as a JPEG or PNG file, scaling and setting the 
compression quality as required. (Note that if you export a movie or PDF document only the 
first frame or first page is exported.) 

Other features 
• Extract and store basic content previews to summarise the contents of most kinds of 

files even if the volume is o;line (including a low-resolution version of photos, a 
contact sheet for movies, a plain text version of O;ice and PDF documents, album 
art for MP3 files, a dump of the structure of sqlite3 database files, or a hex dump of 
other files) 

• Heuristics to identify the language of text documents 

• Basic support for legacy Classic Mac OS files for use when indexing old hard drives, 
including reading PICT images and old Word 5.1 documents, searching on type and 
creator, and more. 

• Built-in (read-only) “ResEdit” command to examine the resource fork of a Classic 
Mac file: 

 
• Files are processed, and indexes are stored, locally on your hard drive, without 

requiring permanent internet access or being dependent on a 3rd party service that 
might be discontinued one day. 

• Built-in PDF viewer with support for extracting a plain text version of the document 
either in the order it occurs in the document or from top to bottom, to work around 
problems that often occur when trying to copy and paste text from a table. 

Recent changes 
• UI changes to make it clearer that the file list is “where you are” while the icon panels 

are “what you’re looking at” (so you can preview similar images or the contents of a 
folder without opening it). 

• Ability to replace duplicate files with hard links (so a file can appear in two locations 
but only use up one lot of storage on disk) 

• Check for software updates when the application starts up 
• Improved filtering so you can exclude archive entries or o;line files from search 

results 



• Incremental searching as soon as you type into search field. Right click on a folder to 
search within that folder. 

• Option to show a flattened view of all the files anywhere within a folder 
• New ‘Movie Maker’ command to create gentle screensaver movies from drone 

footage 
• Reorganised menus, with new section in manual describing menu organisation 
• Better handling of local vs absolute time, including displaying original timezone for 

PDF and HEIC files 
• Summarise common fields in the metadata panel when selecting multiple files 
• Improvements to the icon panel, including options for square thumbnails or to show 

the filename extension when thumbnails without text are shown 
• Fix handling of multiple volumes (eg. /Volumes/Untitled) with the same name 
• Basic support for legacy Palm OS .pdb files, including photos and PalmDoc eBooks 
• New ‘ResEdit’ command to view resource fork of Classic Mac files, plus ability to 

browse by MacResource type in the tag explorer 
• Click on dates, file sizes and GPS coordinates in the metadata panel to toggle the 

display format  
• Improvements to the ‘Export As Image’ command. 
• Fixes related to analysis of certain AIFF, TIFF and PICT files 
• Include TwelveMonkeys and Batik libraries for PICT and SVG support  
• Ability to search within the currently selected directorie(s) or volume(s) 
• Allow specific directories to be excluded from the index by looking for a hidden file 

called ‘.noblitz’ 
• Add ‘Export As Text’ and ‘Export As XML’ commands 
• Improvements to ‘Find Duplicates’ window, including support for finding when you 

have both a ZIP (or other archive) file and a directory containing the expanded 
contents 

• New command to ‘Manage Volumes’ 
• Support for indexing the contents of ZIP and other archives 
• Disk usage pie chart 
• Performance and memory usage improvements 
• Better detection of moved and renamed files 
• Fix description of certain files including source code etc. 
• Automatically reanalyse files that were previously analysed by an older version of the 

software and might not be described as well as they should be 
• Improved PDF viewer, including settings that control how to extract text 
• Improvements to full screen mode (double click any image, text file, PDF document, 

movie, etc. to view it, then press ‘F’ to toggle full screen mode or Esc to close the 
viewer) 

• Add a tag of Language=Code for anything that looks like computer source code 
rather than plain text 

• Searching improvements related to hyphenated words, telephone numbers, 
numbers with a decimal comma, etc. 

• Group fields in the metadata panel by type 
• Sort icons in the folder contents tab to match the sort order of the file list (when you 

click on a column header) 



Known issues 
• The current user interface is primarily intended as a proof of concept to test 

underlying functionality and might be replaced by a very di;erent interface (for 
example, a web-based UI).  

• Several other planned features (removing duplicates of a file to save disk space or 
replacing them with hard links, organising photos into albums, comparing files or 
directories, etc.) haven’t been implemented yet, or only partly implemented. 

• There is no specific integration yet with cloud storage solutions (such as iCloud, 
DropBox, Sharepoint, or Google Drive) 

• Currently the application runs on Macintosh only but a version for Windows is 
planned for a future date, as is a networked version to allow searching across 
di;erent machines. 

Glossary 
Absolute path A complete file path from the root directory of the computer that uniquely 

identifies the location of a file. Absolute file paths start with a slash, eg. 
/Users/rolf/Desktop/receipt.pdf 

Alias A file that contains a reference to another file or directory, usually 
including the filename and file path as a minimum, but possibly 
additional information such as the file ID that can help locate the file if 
the original file is renamed or moved. Unlike soft links, an alias is a 
normal file that the Finder (and most other Mac software, but not all) 
needs to interpret to access the original file. Aliases are called 
“shortcuts” on Windows.  

Archive Some file formats like ZIP (but also TGZ, JAR, TAR, DMG, 7Z, etc.) wrap up 
a whole directory of files into a single archive file that makes it easier to 
share a lot of files in one go, and often also compresses them to take up 
less space. Blitz Indexer lists all the individual files in the archive, saving 
you from having to expand the archive to see what it contains. 

Bundle Any package that has a standardised structure including a Contents 
subdirectory and Info.plist file 

Classic Mac The original Apple Macintosh operating system, in use from 1984 to 2001, 
which used a di;erent way to represent files from later versions of macOS 
(for example by using type and creator codes rather than filename 
extensions, and storing the contents of a file in two parts, the so-called 
‘data’ and ‘resource’ forks). 

Desktop A special subdirectory in your home directory where the Finder displays 
any files in this folder on the background of your screen. 

Directory Another name for a folder. (‘Directory’ is normally used when talking 
about the underlying file system, while ‘folder’ is what the user sees in the 
Finder, but they are the same thing.) 

Document A file containing useful user data, perhaps a spreadsheet or an image you 
have edited or a Word document, which you can open and edit in the 



application that created it and then save, with a di;erent name or to a 
di;erent location if desired. Documents are files you can manipulate 
directly and are typically stored in your Documents folder or on the 
desktop. Some applications use documents, while others use a library 
user interface. 

Exif metadata EXIF is a standard, agreed between camera manufacturers, for including 
extra technical information about the photo alongside the image itself in a 
digital image file such as JPEG or TIFF. This metadata comes from the 
camera and generally includes the date and time the photo was taken 
and camera settings such as the exposure, lens focal length, whether 
flash was used and much more. Photos taken on a mobile phone will 
usually also include latitude and longitude GPS location information. 

Extended attrs Files on the Mac can have special metadata which is stored by the file 
system, not in the contents of the file. These extended attributes include 
Finder metadata as well as other app-specific data. In Blitz Indexer 
extended attributes appear in the FinderTags, DownloadFrom, Quarantine 
and Comments fields and whether a photo is hidden or a favourite. 

Extension Part of the filename following a period that is usually used to describe the 
type of a file. Common filename extensions include .JPG, .DOCX, .TXT, 
.ZIP, or .PDF. Extensions can be in upper or lower case. Because a 
filename can include periods and other punctuation as part of the name 
it’s not always clear what is an extension and what is part of the name. 
Blitz Indexer assumes that something is an extension if it is up to 8 
characters long and only consists of the letters A-Z and digits 0-9. 

File A named collection of data such as an image, document, or other 
information stored on a device. Files have a filename and may have an 
extension such as .docx or .jpg, and are usually organised into folders. 

File path For a file on a volume to be accessible you need to be able to get to it by 
following a chain of folders from the root directory of that volume. This 
will give you the file path, for example RootDirectory → Folder → Subfolder 
→ Filename.ext, written /RootDirectory/Folder/Subfolder/Filename.ext 

File system How the computer organises files on a storage device. Common types of 
file system include Apple HFS+, APFS, and FAT32. 

Finder The default file manager and user interface software on the Mac. 

Folder A named collection of files or other folders, a place where to “put” files. 
Folders are also known as directories. Most computers have predefined 
special folders such as your desktop folder, Documents and Downloads 
folders and more, but you can also create your own named folders and 
put folders inside other folders (also known as sub-directories). 

FOURCC A ‘four character code’ such as ‘TEXT’ or ‘MooV’ or ‘icl4’ used by some 
systems (such as QuickTime or Classic Mac OS) to define the type of a 
file or a piece of data. The advantage of such codes is that they can be 
stored very e;iciently using a single 32-bit integer while still being 
mnemonic. 



Hard link With some types of file system it is possible for the same file to have 
multiple file paths that refer to it – one file can literally be in more than 
one place. You can create additional hard links to a file and each link to 
the file is as good as any other. There is no such thing as the ‘original’ or 
‘main’ location and it’s only after you delete all the places where the file 
exists that the storage taken up by file itself is freed up. 

Hash A hash (or checksum) is a number calculated by reading the contents of a 
file so that if two files are identical they will have the same checksum, 
and if two files have the same checksum it’s very likely (but not absolutely 
guaranteed) that they are the same. Hashes are commonly used to detect 
duplicate files and to verify that a file hasn’t been corrupted or altered. 

HEIC A modern, high e;iciency image format used when taking photos on 
iPhones and other devices. Not all applications, especially on Windows, 
support HEIC files so you may need to save images as a JPEG file for 
maximum compatibility. 

Home directory The top-level directory where all the user’s files and folders are stored, 
including the Desktop and Documents folders. The home directory is 
sometimes hidden and you are discouraged from accessing it directly 
because moving or renaming files there can stop the system working 
properly. 

JPEG The most common file format for storing digital photos and other images. 
JPEG files use lossy compression but if you choose a high compression 
quality setting the losses are virtually imperceptible for photos, though for 
graphics and screenshots PNG files are more appropriate. Like TIFF and 
raw files, JPEG files often contain Exif metadata about when the photo 
was taken. 

Library A collection of useful data where access is controlled automatically by 
the application that owns it. Even though the data is stored in normal files 
behind the scenes, these files aren’t directly exposed to the user in the 
user interface, and if you should happen to move or rename one of the 
files the software is likely to stop working. On the Mac, applications like 
Contacts and Photos use a library interface, while others like Pages and 
Word, or Numbers and Excel, use a document interface.  

Link There are several mechanisms by which you can “link” a file to make it 
appear in another folder from where it was originally created: soft links, 
hard links, and aliases. These all let you access the same file from more 
than one location but each mechanism has di;erent pros and cons. 

Metadata Information describing a file that will help you find it and know what is in 
it. This includes file system metadata (such as the filename, extension, 
and last modification time) and metadata that might be stored or 
“embedded” in the file itself, such as the title and author of a document 
or Exif metadata in photos. 

Mounted When a volume is connected and made available to the operating system 
so its files can be accessed. When you plug in a memory stick or USB 
drive it is normally mounted automatically after a few seconds. 



O;line O;line just means “not connected” and is used in two di;erent contexts 
in Blitz Indexer. An o;line volume is a hard disk or memory stick that isn’t 
currently connected (or mounted) so the files on it aren’t accessible, even 
though those files and a concise summary of their contents might be 
listed in the index. O;line operation means the software stores its data 
locally and will work without requiring a connection to the internet. 

Package A folder that appears as if it were a single file in the Finder (for example 
.app application bundles, a Photos library, installer packages, etc.). 

Palm OS The operating system (and file format) used by PalmPilot and other PDAs 
from 1996 to 2011. 

PDF Portable Document Format, a kind of file that is very widely used to store 
a read only printable version of a document for sharing with people who 
don’t have the application needed to open the original file. PDFs are 
usually generated by “printing” the original document but then choosing 
“Save As PDF” when the print dialog window appears. PDFs can contain 
metadata such as the author of the document. 

Permissions Files and directories have permissions associated with them by the file 
system that control which users can read or write the file. 

PNG Another common image format, especially suitable for graphics and 
screenshots because, unlike JPEG, PNG compression is lossless. 

Query syntax Special characters and keywords that have a particular meaning and can 
be typed in when searching for files to refine the search (for example to 
search by filename rather than by contents of a file). 

QuickTime Apple’s original format for movie files dating all the way back to Classic 
Mac OS. They have now largely been replaced by MP4 files for 
distribution, though both MP4 and QuickTime MOV files share the same 
underlying structure and Blitz Indexer will read metadata from either. 

Relative path Unlike absolute paths, a relative path is incomplete and specifies the 
location of a file relative to a particular folder. 

Root directory Every volume has a single top-level folder or root directory which 
ultimately contains all the files on that volume, either directly in the root 
directory or in a (nested) sub-directory of the root directory. 

Raw file Digital cameras usually give you the option whether to save images as 
JPEG or raw files. Raw files are larger and less compatible (you will 
generally need specialised digital photography software to work with 
them) but give access to the raw sensor data for the best possible quality, 
especially if you want to do detailed colour correction. 

Soft link A soft link (also called a “symbolic link”) is a special kind of file that stores 
the path (either absolute or relative) to another file or directory. Unlike 
aliases, soft links are stored in the file system itself, not in the contents of 
the file. 

Spotlight Apple’s built-in software for indexing and searching files. Although 
superficially there is overlap between Spotlight and Blitz Indexer some 
key di;erences include that Blitz works with both online and o;line files, 



is much more transparent about what it is doing, and will index everything 
rather than silently ignoring files that the system doesn’t want you to 
know about. 

System file While a user is primarily interested in “useful” files such as documents or 
photos or applications there are also lots of files such as log files, code 
libraries, caches, settings files and countless other data that are used 
behind the scenes by the operating system. Such system files are often 
protected or hidden from view by default. 

TIFF A lossless digital image format commonly used in professional 
photography. 

Volume A storage device such as a hard disk, a USB drive, a shared network 
folder, or a memory stick, especially when it is connected to the 
computer (is “mounted”) and appears as an icon on your desktop or 
sidebar, is known as a volume. (More accurately, a volume is actually a 
“logical” storage container, so a physical device such as a hard disk might 
actually be split into di;erent partitions and have several volumes on it, 
but for most purposes a volume can be thought of as a drive or disk.)  

XML A highly structured text file, not intended to be viewed or edited directly by 
users but for storing data by software. Commonly used for exchange of 
data between applications. 

XMP Metadata standard widely used by Adobe and other software. Unlike Exif 
metadata, which has information from when the photo was originally 
taken, XMP metadata is generally added later as part of a complete digital 
workflow and describes how an image was edited and where it is used. 
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